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Upon Receipt of Product

Prior to operation, check for loosened hardware or damage incurred during transit. If these conditions
are found, a safety hazard is likely, DO NOT attempt to operate equipment. Please contact Megger as
soon as possible.

TTR300 Transformer Turn Ratio test set
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Getting to know the TTR300

Product Overview

The Three-Phase TTR® Test Set is fully automatic, self-checking, unit which is
designed to be controlled via a computer running either PowerDB or PowerDB
Lite software programs. The test set measures the turn ratio, phase shift, and
excitation current of power, distribution, and instrument transformers. A “-47”
suffix added to the catalog number denotes a 230-V input power supply, rather
than the standard 120-V supply. The test set is a portable instrument housed in a
sturdy plastic case with removable lid and carrying strap. The inside lining of
case is metal shielded. A canvas carrying bag is supplied to hold all accessories.

The test set can be used to test single-phase and three-phase transformers, both
with and without taps in accordance with the requirements of the IEEE
(C57.12.90 — 1997 standards. For three-phase measurements, the test set is
connected to all three phases of the transformer to be tested. The TTR lead
selection circuitry permits automatic measurement of all phases without changing
connections. This feature eliminates the need to refer to hook-up charts when
testing three-phase transformers. Transformer excitation current as well as phase
shift angle helps to detect transformer shorted turns or an unequal number of
turns connected in parallel. Operating condition (error) messages identify
incorrect test connections, abnormal operating condition, or winding problems.
Test results are saved to an external personal computer (PC) via an RS232 serial
port.

Features include:

Fully automatic operation.

Self-checking at power-up.

User-friendly, menu-driven operation (via PC)

AVTMTTR300 Rev B Sept 2008 5
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Test turn ratio, phase shift (in both degree and centiradian), and excitation
current.

Easy measuring of regular windings, tertiary windings, and CTs.
Checking reverse polarity at start of each test.

Via ethernet port, an external PC or laptop is connected to operate the
TTR (in remote control mode) and to transfer test results and to provide
tull transformer test report.

Quick test mode provides the fastest testing of a transformer.
Three excitation test voltages: 80 V, 40 V, and 8 V.

Testing to ANSI, IEC, and Australian standards.

Leads marked to ANSI, IEC, and Australian standards.
Multi-lingual support.

Meets the requirements of both the European EMC and Low Voltage
Directives.

It is recommended that the user becomes familiar with the TTR300 before ever
connecting to a transformer.

AVTMTTR300 Rev B Sept 2008



Getting to Know the TTR300

1.1 Top Panel Controls

Figure 1-1. Top Panel Controls

Power input receptacle, ON/OFF switch, and fuse holder. ON/OFF
power switch and input power receptacle provides power to the test set.

Emergency OFF switch. This red push button interrupts testing. When
pressed, the switch is locked in off position. To reset the switch, twist the
button in the direction indicated by the arrows.

Voltage ON light. Red indicator lamp indicates when lit that test voltage is
being supplied to the Unit Under Test (UUT).

Remote Trigger receptacle. Plug receptacle for connecting Remote
Trigger cable for testing transformers with Load-Tap-Changers.

H - Cable receptacle. Plug receptacle for connecting test leads to the high-
voltage (H) winding of a transformer

X — Cable receptacle. Plug receptacle for connecting test leads to the low-
voltage (X) winding of a transformer.

Ground lug. Wing-nut terminal allows connection of test set to Station

Earth ground.
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Safety

Safety is the responsibility of the user

Only qualified and trained operators should operate the TTR300 system.
Operator must read and understand this entire Instruction Manual prior to
operating the equipment. Operator must follow the instructions of this
Instruction Manual and attend the equipment while the equipment is in use. In
the event of equipment malfunction, the unit should immediately be de-
energized and returned to Megger for repair. The Safety precautions herein are
not intended to replace your Company’s Safety Procedures. Refer to IEEE 510 -
1983, IEEE Recommended Practices for Safety in High-Voltage and High-
Power Testing, for additional information.

General Safety Precautions

The TTR300 and the Unit Under Test (UUT) should both be considered as
sources of instantaneously lethal levels of electrical energy. Observe the
following safety precautions:

= Observe all safety warnings on the equipment. They identify areas of
immediate hazard that could result in injury or death.

= Use this equipment only for the purposes described in this manual.
Observe strictly the Warning and Caution information provided in this
manual

= Treat all terminals of high-voltage power equipment systems as potential

electric shock hazards. Use all practical safety precautions to prevent
contact with energized parts of the equipment and related circuits.

. Use suitable barriers, barricades, or warnings to keep persons not directly
involved with the work away from test activities.

. Never connect the test equipment to energized equipment.

AVTMTTR300 Rev B Sept 2008 9
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= Do not use in an explosive atmosphere.

. Use the grounding and connection procedures recommended in this
manual. Always disconnect test leads from power equipment before
attempting to disconnect them at the test set. The ground connection must
be the first made and the last removed. Any interruption of the grounding
connection can create an electrical shock hazard.

= Personnel using heart pacemakers should obtain expert advice on the
possible risks before operating this equipment or being close to the
equipment during operation.

Input Power Precautions

This instrument operates from a single-phase, sine wave, power source. It has a
three-wire power cord and requires a two-pole, three-terminal (live, neutral, and
ground) type input source. The voltage to ground from the live pole of the
power source must be within the following rated operating voltage:

For Cat. No TTR300 120 V £10%, single phase sine, 50/60 £2 Hz
For Cat. No. TTR300-47 230 V £10%, single phase sine, 50/60 +2 Hz

The neutral pole must be at ground potential. Before making connection to the
power source, determine that the instrument rating matches the voltage of the
power source. The power input plug must be inserted only into a mating
receptacle with a ground contact. Do not bypass the grounding connection. Any
interruption of the grounding connection can create an electric shock hazard.
Determine that the receptacle is properly wired before inserting the plug.

For test sets energized with 230 V input (TTR300-47), the neutral terminal of the
input supply cord (white or blue lead) must be connected to the neutral pole of
the line power source. The ground terminal of the input supply cord (green or
yellow/gtreen lead) must be connected to the protective ground (earth) terminal
of the line power source. The black or brown cord lead is the live (hot) lead.

The control circuits of the instrument are protected by two mains circuit fuses.
These fuses are located in the ON/OFF switch module and are replaceable by
the operator. To avoid electric shock and fire hazard, use only the fuse specified
in Sections 1 and 8, that is identical in respect to type, voltage rating, and current
rating. Refer to the Fuse Replacement procedure in the Service section.
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WARNING
Before replacing the fuses, disconnect the
power input plug from the live power source.
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PREPARING FOR TEST

3.1 Site Preparation

Choose a location that meets the following conditions:

= The location is as dry as possible.

. There is no flammable material stored in the vicinity.

= The test area is adequately ventilated.

. Be sure all equipment is de-energized and all terminals of the UUT are

accessible. Erect suitable safety barriers to protect the operator from
traffic hazards and to prevent intrusion by unauthorized personnel. User
provided Warning lights are recommended.

= Verity that the Local station ground is intact and has impedance continuity
to earth.
3.2 Making Circuit Connections

Connections should be made in the order as listed below.

3.2.1 Ground. Use the Megger supplied Safety Ground Cable 15 ft (4.6 m) to
connect the TTR300 Wing Nut Ground Terminal directly to Local
Station Earth ground. Ensure the Transformer chassis also has
impedance continuity to Local Station Earth ground potential.

3.2.2 Input Power Source Ground. Input Power Source Ground Terminal
should be less than 100 milliohms of impedance to Local Station Earth
Ground.

3.23 Connect the Input Power Cord. Before making this connection,
Ensure the Input Power Source meets the requirements as listed in

AVTMTTR300 Rev B Sept 2008 13
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3.24

3.25

3.2.6

3.2.7

Section 2 and Specifications Section 8. Also make sure that the ON/OFF
switch (Figure 1-1, No. 1) is in the OFF position. Connect the input
power cable to the TTR300 first, then to the power source. At this time,
leave the ON/OFF switch in the OFF position.

Connect the Serial cable. For operation of the TTR300 in a remote-
control mode, using PowerDB PC software, then connect the Serial cable
between the TTR300 and the PC at this time.

Connect the Load-Tap-Changer cable (optional). If the user
chooses to operate the “Test button” of the TTR300 from a remote
distance then, connect the LTC cable at this time.

Connect the H and X leads (to the TTR300 end only at this time).
With the clamps disconnected from the UUT, connect the Bayonet Plug
on the Cable labeled “H” to the TTR panel connector also labeled “H”.
Repeat this process for the “X” labeled cable. Ensure each connector is
securely fastened using a clockwise rotation.

Connect the H and X clamps. With the ON/OFF Switch in the OFF
position, connect the H and X clamps in accordance with Section 4 as
appropriate for the specific transformer type and test to be conducted.

AVTMTTR300 Rev B Sept 2008
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Connecting to the Transformer

The setup and connection instructions included in Section 4 herein, pertaining to
ratio, polarity, and phase relation, assume that the transformer under test,
connections, and terminal markings comply with the requirements of ANSI
C57.12.70-1990 American National Standards Terminal Markings and Connections for
Distribution and Power Transformers. The H test leads of the test set are the exciting
(high voltage) leads (8 V, 40 V, or 80 V). The X test leads are the low voltage

leads.

When testing high-voltage transformers, caution must be used at all times and all
safety precautions followed. Read, understand, and employ all safety precautions
and circuit connections described in Sections 2 and 3 herein.

WARNING
Ensure that the transformer to be tested is completely
de-energized. Check every winding. Ensure that all
terminals of the transformer are disconnected from line
or load at the transformer. Connections to ground may
be left in place.

WARNING
For all testing as described herein, care shall be taken
to ensure any and all unused clamps shall be isolated
from each other, from ground, and from personnel.

WARNING
Except for CTs as described herein, never interchange
connections between the high- and low-voltage
transformer terminals. Failure to observe proper
connections will result in a safety hazard and may result
in damage to the test set or transformer.

AVTMTTR300 Rev B Sept 2008
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Single-Phase, Two-Winding Transformers

Perform the following setup procedure for single-phase, two-winding
transformers:

1.

H2 X2
H2 LEAD X2 LEAD
_i O O

With the ON/OFF Switch in the OFF position, make the circuit
connections as desctribed in Section 3.2.

Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

Connect the heavy-duty clamps marked H1 and H2 of the test lead to the
corresponding (high-voltage winding) terminals of the transformer under
test. Figures 4-1 and 4-2 show test setups for single-phase transformers.
Figures 4-3 and 4-4 show test setups for regulators.

Connect the heavy-duty clamps marked X1 and X2 of the test lead to the
corresponding (low-voltage winding) terminals of the transformer under test.
Figures 4-1 and 4-2 show test setups for single-phase transformers. Figures
4-3 and 4-4 show test setups for regulators.

On/OFF Switch. Itis only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satistied, should the
On/OFF switch be turned to the ON position.

[ H1 LEAD X1 LEAD
O @)

H1 X1

1 TRANSFORMER

Figure 4-1. Setup for Testing Single-Phase Transformer

AVTMTTR300 Rev B Sept 2008
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Connecting to the Transformer

HI LEAD.
HI
XI_LEAD. o
2 TTR X 3 AUTOTRANSFORMER
H2 LEADS
H2
f—i | x2 LEAD 1 X2

Figure 4-2.  Setup for Testing Single-Phase Autotransformer

To test windings other than H1 — H2 and X1 — X2, ensure that the heavy-duty
clamp marked H1 is connected to the lower numbered terminal and H2 to the
higher numbered terminal of the high-voltage winding. Similarly, X1 and X2
should be connected to the low-voltage winding.

Test lead markings for the ANSI, CEI/IEC, and Australian standards ate as
shown in Table 4-1.

Table 4-1. Test Lead Markings for Single-Phase Transformers

Test Lead Marking Transformer Heavy-Duty Test Lead
Clamp
ANSI | CEI/IEC | Australian | Terminal Voltage Boot Color Color Band
H1 1U A, High Red Red
H2 1V A High Red Yellow
X1 2U a, Low Black Red
X2 2V a Low Black Yellow

AVTMTTR300 Rev B Sept 2008 17
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X1 LEAD
SERIES
WIND ING
"RAISE"
DIRECT ION
SOURCE L
_|H1 LEAD _—©
o § : :
R
LOAD
D TR SHUNT
WINDING

H2 LEAD
COMMCN
X2 LEAD /I

Figure 4-3. Setup for Testing Single-Phase, Type A (Straight Design) Step Voltage
Regulator

X1 LEAD

SERIES
WIND ING

SOURCE
H1_LEAD @ £_I—— "
C e o=

"RAISE"
3@ TTR DIRECTION

SHUNT
WINDING

i H2 LEAD
X2 LEAD /1 COMeN

Figure 4-4.  Setup for Testing Single-Phase, Type B (Inverted Design) Step Voltage
Regulator
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Connecting to the Transformer

Three-Phase, Two-Winding Transformers

Perform the following setup procedure for three-phase, two-winding
transformers:

1.

With the ON/OFF Switch in the OFF position, make the circuit
connections as desctribed in Section 3.2.

2. Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

3. Connect the heavy-duty clamps marked HO, H1, H2, and H3 of the test lead
to the corresponding (high-voltage winding) terminals of the transformer
under test. Refer to Table 4-2 for test lead markings. With delta connected
windings, HO is not used. With wye connected windings, a neutral
connection for HO is normally available.

4. Connect the heavy-duty clamps marked X0, X1, X2, and X3 of the test lead
to the corresponding (low-voltage winding) terminals of the transformer
under test. Refer to Table 4-2 for test lead markings. With delta connected
windings, X0 is not used. With wye connected windings, a neutral
connection for X0 is normally available.

5. On/OFF Switch. Itis only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satisfied, should the
On/OFF switch be turned to the ON position.

Table 4-2. Test Lead Markings for Three-Phase Transformers
Test Lead Marking Transformer Heavy-Duty Test Lead
Clamp
ANSI | CEI/IEC | Australian | Terminal Voltage Boot Color Color Band

HO IN N Neutral Red White

H1 10 A/A, High Red Red

H2 1v B,/B, High Red Yellow

H3 1w C,/C, High Red Blue

X0 2N N Neutral Black White

X1 2U a,/a,/a, Low Black Red

X2 2V b,/b,/b, | Low Black Yellow

X3 2W c,/c/¢y Low Black Blue

Note: According to Australian standard, wye and delta transformer winding

connections have a numerical suffix of 1 and 2. The zigzag transformers
have a numerical suffix of 4. See Table A-3.

AVTMTTR300 Rev B Sept 2008
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Three-Phase, Three-Winding Transformers

This type of transformers has primary, secondary, and tertiary windings. Primary
and secondary windings are tested as a regular three-phase, two-winding
transformer. To test tertiary winding, perform the following setup procedure:

1.

With the ON/OFF Switch in the OFF position, make the circuit
connections as desctribed in Section 3.2.

Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

Connect the heavy-duty clamps marked HO, H1, H2, and H3 of the test lead
to the corresponding terminals of the transformer under test. Refer to Table
4-2 for test lead markings. With delta connected windings, HO is not used.
With wye connected windings, a neutral connection for HO is normally
available

Connect the heavy-duty clamps marked X0, X1, X2, and X3 of the test lead
to the corresponding tertiary (low-voltage winding) terminals (Y0, Y1, Y2,
and Y3) of the transformer under test. Refer to Table 4-2 for test lead
markings. With delta connected windings, X0 is not used. With wye
connected windings, a neutral connection for X0 is normally available.

On/OFF Switch. Itis only after all of the above connections are safely
made and all safety precautions of sections 2 and 3 are satisfied, should the
On/OFF switch be turned to the ON position.

Current Transformers (CTs)

Connections to CT's are made backwards compared to power or potential
transformers. The H terminals on the test set must be connected to the X
terminals on the CT; and the X terminals on the test set must be connected to
the H terminals on the CT.

NOTE:  Dots on the housing of the transformer are commonly used to identify

terminals of the same polarity.

AVTMTTR300 Rev B Sept 2008
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Connecting to the Transformer

WARNING
Failure to observe proper connections will result in a
safety hazard and may result in damage to the test set
or CT. Failure to observe voltage rating of low-current X
winding may result in damage to the CT.

CAUTION
Never use AUTO mode of operation when testing the
current transformers with the rated voltage below
80V ac.

Most of the CT's are tested at 8 V ac excitation voltage.

NOTE:  Most of the current transformers are tested at 8 1 ac excitation voltage.

Some current transformers with turn ratio of 100:5 and less get
saturated at 81" ac. They require lower excitation voltage for testing and
therefore can not be tested with the Cat.No TTR300. For this case, use
the TIR100 or TTR25.

Unmounted CTs

With the ON/OFF Switch in the OFF position, make the circuit
connections as described in Section 3.2.

Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

As shown in Figure 4-5, connect the heavy-duty clamps marked H1 and H2
of the test lead to the respective X1 and X2 terminals of the CT. Note that
the H and X leads are connected in reverse as compared to the Single and
Three phase Transformer testing described in the previous sections.

As shown in Figure 4-5, connect the heavy-duty clamps marked X1 and X2
of the test lead to the respective H1 and H2 terminals of the CT. Ensure
correct polarity. Note that the H and X leads are connected in reverse as
compared to the Single and Three phase Transformer testing described in the
previous sections.

AVTMTTR300 Rev B Sept 2008
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POLARITY H1 LEAD H2 LEAD
DOT
X1 X2
\O H2
b &
X2 LEAD

BUS OR USE
HEAVY GAUGE

LEAD WIRE
e

CT

X1 LEAD

NOTE: TEST PER DIAGRAM NO. 1 FOR ANSI,
CEI/IEC & AUSTRALIAN STANDARDS

Figure 4-5.  Setup for Testing Unmounted Current Transformer

Figure 4-6 shows the setup for testing the taps on a multiple-tap CT.

H1 LEAD
O
X1
X1 LEAD
O
X2
H1
_ X1 LEAD o
30 TTR
X3 H2
X1 LEAD
—————— >
X4
H2 LEAD X5
1 5

X2 LEAD/' TRANSFORMER

NOTE: TEST PER DIAGRAM NO. 1 FOR ANSI,
CEIZIEC & AUSTRALIAN STANDARDS

Figure 4-6.  Setup for Testing Taps on Multiple Tap CT
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Connecting to the Transformer

Bushing Current Transformer (BCT) Mounted on Single-Phase,
Two-Winding Transformer

A turn-ratio test can be performed on a BCT after it has been mounted on a
circuit breaker or power transformer entrance bushing. The test can be
performed without removal of the BCT from the equipment. Proceed as follows:

1.

With the ON/OFF Switch in the OFF position, make the circuit
connections as desctribed in Section 3.2.

Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

Using user supplied shorting jumper leads, short-circuit the winding on the
opposite voltage side of the power transformer core.

Connect the heavy-duty clamps marked H1 and H2 of the test leads to the
respective X1 and X2 terminals of the BCT as shown in figure 4-7.

Connect the heavy-duty clamp marked X1 to the power transformer terminal
on which the BCT is mounted and the X2 heavy-duty clamp to the terminal
on the opposite side of the power transformer winding (H2 side of BCT).
Check to make sure that the BCT is mounted with proper polarity with
respect to power transformer entrance bushing and that connection polarities

are correct.
BCT POLARITY MARKER (TYP)
\ Q X1 LEAD

e [Hi

-
\ E— , H1 LEAD
| — |

L 1 X2 H2 LEAD

JR |

JUMPER
LEAD

X2 LEAD

POWER
TRANSFORMER

NOTE: TEST PER DIAGRAM NO. 1 FOR ANSI,
CEI/IEC & AUSTRAL IAN STANDARDS

Figure 4-7.  Setup for Testing BCT Mounted on Single-Phase Two-Winding Transformer

AVTMTTR300 Rev B Sept 2008
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BCTs Mounted on Three-Phase Transformers

A turn-ratio test can be performed on all three BCT's using a single setup. Figure
4-8 shows how (to make the proper connections) when the BCTs are mounted
on a typical delta winding and Figure 4-9 shows how when mounted on a typical
wye winding.

1.

With the ON/OFF Switch in the OFF position, make the circuit
connections as desctribed in Section 3.2.

Connect the H and X test cables to the respective H and X receptacles of the
TTR300. Make sure that the connectors are securely fastened (using
clockwise rotation) to the receptacles.

Short-circuit all windings on the opposite voltage side of the power
transformer core using jumper leads.

Check to make sure that all BCT's are mounted with proper polarity with
respect to the power transformer entrance bushing. Ensure that all
connection polarities are correct. Make connections as shown in figure 4-8
for delta winding configurations and figure 4-9 for wye winding
configurations.
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H2
O X2 LEAD
e | H1
@ X1
ug H2 LEAD
E"_ X2
O
H2
BCT (TYP) —/
JUMPER
IIAII IICII
® ®
HT1 O H1 r}f\ H2 H2 /}/\ H1 o H3
® ®
X1 | X2 X2 | X1
o O —> O O
JUMPER /r
X1 LEAD H3 LEAD
H1 LEAD X3 LEAD
HO LEAD

X2

X3

X2
X1 X3

JUMPER LEADS

(TYP)

BCT TEST SELECTION

WIND ING STANDARD DIAGRAM NO. IEC VECTOR CODE
ANS | 19 YNyO
CEI/IEC YNyO
AUSTRAL | AN YNyO
PHASE A TEST: MEASURES BCT ON H1 POWER TRANSFORMER TERMINAL (BCT "A")
PHASE B TEST: MEASURES BCT ON H2 POWER TRANSFORMER TERMINAL (BCT "B")
PHASE C TEST: MEASURES BCT ON H3 POWER TRANSFORMER TERMINAL (BCT "C")

Figure 4-8.
Transformer

Setup for Testing BCT Mounted on Delta Winding on a Three-Phase Power
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H2

H1

H3

H1 LEAD HO LEAD H2 LEAD

H2

H1 H3

JUMPER LEADS

(TYP)

H3 LEAD

JUMPER

&
K
»
o o
X1 xz%
[
H1 || IH2
n All
BCT (TYP)
BCT POLARITY
MARKER (TYP)
X1 LEAD X0 LEAD

5]

X3 LEAD X2 LEAD

BCT TEST SELECTION

WINDING STANDARD TABLE NO. DIAGRAM NO. IEC VECTOR CODE
ANS | 5-4 7 YNynO
CEI/IEC 29 YNynO
AUSTRAL | AN 13 YNynO
PHASE A TEST: MEASURES >OWER TRANSFORMER TERMINAL (BCT "A")
PHASE B TEST: MEASURES >0OWER TRANSFORMER TERMINAL (BCT "B")
PHASE C TEST: MEASURES _.. . - 2OWER TRANSFORMER TERMINAL (BCT "C")

Figure 4-9.
Transformer

Setup for Testing BCT Mounted on Wye Winding of a Three-Phase
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T-Type Transformers

T-type transformers represent a special type of thee-phase transformer. This
transformer may be tested as a single phase transformer. In this case, the jumpers
indicated in Table 4-3 should be applied to the appropriate terminals of the T-
type transformers. The TTR measured turn ratio should be compared to the
calculated turn ratio indicated in Table 4-3.

Table 4-3. T-type Transformer Winding Phase Relationship

Winding Connection Winding Tested
IEC External Phase High- Low-
Vector High-Voltage Low-Voltage jumpers tested Voltage Voltage Calculated
Group Winding (H) Winding (X) Winding Winding Turn Ratio | Remarks
X2 Mu
Ho - A Hq - H, Xi =Xz Vx
T-T
0 A y b Hi -H, ALY
B X1 Xz B Hi—Hs, Xi=Xs %%
Hy Hy | % X3
2
Y/
Vx 2
T-T 5 X b
o A B H,— H Xo = X Vi, 2
ag 2— '3 17— /A3
X Vx 43
Hy Hs X 3 Xi-Xe
Hz X2 Vi 3
Hz -Hs A Hi— Hs X1 = Xs Vit V3
Vx 2
T-T B b
30 A X
lead 3 X —Xs B Hz — Ha Xo-Xi | JH. 2
Hy Hs 4 Vx {3
X
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Operation

Power up

Proceed only after reading and fully reading and understanding Sections 2, 3, and
4 herein, with particular attention on the Safety related precautions.

Once all Safety precautions are taken, and all circuit connections are made, then
the user may safely turn the ON/OFF switch to the ON position and operate
the test instrument as described herein.

EMERGENCY SHUTDOWN

For Emergency shutdown, Push red EMERGENCY OFF
button or toggle On/OFF switch to OFF.

On power up, a beep sounds, the test set performs a self-test check, and all
hardware and software variables are initialized. Proceed to Addendum A for
operation via external PC (supplied by User).

Remote Control Operation for LTC Testing

Use the remote control mode of the TTR for load tap changer (LTC) testing.
The remote control mode provides two-way-communication between the
operator and the TTR, allowing you to stay close to an LTC, change taps, and
initiate the test routine.

Connect the hand-held control unit, Megger p/n 30915-220, to the Remote
Trigger Receptacle port of the TTR. The remote control unit pushbutton lamp
will illuminate.

Now an operator may come to the remote location, and set (for example), the
LTC to the desired position, and would then depress the remote control unit
pushbutton for a short time, then release it. The pushbutton lamp extinguishes
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until the TTR is ready for the next test. When the current testing is complete, the
test results are automatically saved, the pushbutton lamp lights, and the TTR test
set is ready for the next remote test

Error Messages

When an error message appears, indicating an abnormal operating condition,
verify the condition by taking a repeat measurement before attempting to take
any corrective action.

Open connections, wrong connections, open windings, shorted windings, high
resistance windings, other abnormal transformer problems, or a combination of
these may cause a large deviation from normal turn ratio or indicate an unusual
message. The unusual operating conditions may be caused by an abnormal
leakage reactance or capacitive coupling within the transformer windings. If
abnormal operating conditions occur during transformer testing, error messages
may appear (such as below) and may be accompanied by three short beeps.

CHECK CONNECTTIONS

This message indicates that the transformer is not connected to the test set. The
message may be caused by poor connection of one of the test leads, as well.

PHASE A (or B, or C) EXCITATION CURRENT TOO HIGH

This message indicates that excitation current exceeds 500 mA. Excitation
current can be reduced by using lower test voltages (40 V or 8 V).

TURNS RATIO TOO LOW, <0.8

This message shows that a transformer under test turn ratio is less than 0.8. The
TTR is not designed to test a transformer turn ratio under 0.8.

PHASE A (or B, or C) TURNS RATIO TOO HIGH

This message shows that a transformer under test turn ratio is higher than 10,000
(if 80 V or 40 V is used) or is higher than 4,000 (if 8 V is used). The message may
be caused by poor connection of one of the test leads, as well.

CHECK PHASE A (or B, or C) CONNECTIONS, REVERSED

This message is caused by incorrect connection of the H and X leads. The H and
X leads have either been reversed or the test transformer connections or
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markings do not comply with the requirements of ANSI, IEC, or the Australian
standard. The message may be caused by wrong diagram number specified, as

well.

CHECK PHASE A (or B, or C) POLARITY

This message shows that the H or X test leads are incorrectly connected or the
test transformer connections or markings do not comply with the requirements
of ANSI, IEC, ot the Australian standard.

Upon completion of TEST — Powering down

6.1

6.2

6.3

6.4

6.5

Upon completion of testing, once directed by the on-screen instruction,
Switch the ON/OFF Switch to OFF.

Using an adequately grounded Safety Ground Stick, ground all exposed
high voltage connections. Then, while wearing the appropriately rated
rubber gloves, connect Safety Ground Jumpers from all exposed high
voltage cable terminals to Local Station Earth Ground. Itis a good idea
to leave the jumpers in place for at least as long as the specimen was at
test voltage.

Remove the Test Instrument clamps from the Transformer, leaving the
Safety Ground Jumper in place to drain any stored charge.

Disconnect the Power Cord from the Input Power Source.

Lastly, disconnect the safety ground cable.
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Service

Maintenance

Maintenance should be performed only by qualified persons familiar with the
hazards involved with high-voltage test equipment. Read and understand
Sections 2, 3, 4, and 5 before performing any service.

The TTR300 requires only periodic inspection. Periodically, inspect all hardware
items including the cable assemblies to ensure all is in good condition.

The TTR300 may be cleaned periodically. In so doing, do not allow water to
penetrate panel holes. An all-purpose, household spray cleaner can be used to
clean the panel. Polish with a soft, dry cloth, taking care not to scratch the
display screen cover. Clean the cables and mating panel receptacles with
isopropyl or denatured alcohol applied with a clean cloth.

Fuse Replacement

The TTR300 is protected by two mains fuses. Fuse replacement is indicated if
the electronic circuits do not function. Refer fuse replacement to qualified
personnel only. To avoid electric shock and fire hazard, use only the fuses
specified on Instrument panel.

WARNING
Before replacing the fuses, disconnect the power input
plug from the live power source.

To replace fuse(s), proceed as follows:
1. Disconnect the power cord from the TTR test set.

2. Using a small flathead screwdriver, carefully pry out the fuse holder of the
input power module (item 1 of figure 1.1).
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3. Remove and properly dispose of spent fuse(s).
4. Install new fuse(s) making sure to use the type specified on Instrument panel.

5. Reinstall the fuse holder in its receptacle in the input power module. Connect
the power cord to the TTR test set and to an energized power source. If the
electronic circuits still do not function properly, contact the factory for
service.

Calibration

A complete performance and calibration check should be made at least once
every year. This will ensure that the TTR test set is functioning and calibrated
propetly over the entire measurement range. The 3-phase TTR calibration is
performed on each new or repaired unit before sending it to a customer. There is
a special 3-phase TTR final calibration procedure which requires a NIST-
traceable test equipment to be used. As a result of such calibration procedure,
each TTR test set may be NIST certified.

To check the 3-phase TTR calibration at a customer site or in the field, the
Megger Calibration Standard Cat. No. 550055 or equivalent standard should be
used. To perform a quick simplified calibration check, the Megger Calibration
Standard Cat No. 550555 may be used. The last standard has eleven switchable
turns ratio settings which cover the turns ratio range from 1:1 to 2000:1.

TTR300 - Self check

A customer may want to make sure that the test set is functioning propetly
before testing a transformer. Traditionally, for transformer turns ratio testers, a
customer performed this test by connecting H1-X1 and H2-X2 test leads. The
1:1 turns ratio was expected to be measured. Additionally, the displayed test
results were interpreted as a test set calibration check.

The 3-phase TTR test set is designed and optimized for the transformer turns
ratio testing. It uses a mixed analog-digital technique to provide the high accurate
readings of the tested transformer turns ratio. The test set measurement
approach is based on high impedance input and output transformer voltage
monitoring circuits. The high impedance of the monitoring circuits is optimized
for the accurate transformer turns ratio testing.

When performing a 3-phase TTR functional test, the H and X test leads
interconnect the input and output monitoring circuits without a transformer
being connected. Such connection cause an impedance mismatch and, as a result
of the mismatch, the displayed turns ratio reading is not exactly 1:1 as it may be
expected. A customer should be aware that a functional test is not a real
transformer turns ratio test. Due to the intrinsic and inevitable impedance
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mismatching, the 3-phase TTR functional test readings may be from 0.9980 to
1.0020. The TTR functional test readings do not represent its calibration. It
simply shows that the TTR test set circuitry functions properly. To check the 3-
phase TTR calibration, a customer should use the Calibration Standards
mentioned in Calibration section of the manual.

To perform a 3-phase TTR functional test proceed as follows:
1. Turn TTR test set power off.

2. Connect H1 and X1 clamps to an electrically common point (such as an
unused bare wire). Likewise, electrically connect the H2 and X2 clamps, the
H3 and X3 clamps, and lastly, the HO and X0 clamps. Directly connecting
two clamps together may cause erroneous results as it is very difficult to have
all four sides (within the two clamps) make contact with each other (as the
TTR300 utilizes “Kelvin” type leads, it is necessary, for this 1:1 quick check,
that all four sides of each clamp pair are electrically common). Also, make
sure the leads are propetly connected and that H/X pairs are not electrically
in contact with each other.

3. Turn TTR test set power on.
4. After self-test is complete and the unit is ready for testing:

5. Enter transformer type DIAG 07 YNynO.
WARNING

Do not continue functional test if the diagram type DIAG
07 YNynO transformer type is not listed.

Keep the leads, which are energized, clear of ground,
and personnel, and each of the other lead-pair sets.

6. Start TEST

7. 'The readings for phases A, B, and C should be:
RATIO: 1.0000 £0.0020
PHASE (min): 0 £5

Iexc (mA): 0.0 to 0.5

8. If needed, (as identified on the Preference screen), perform the test
according to steps 1 through 7 for all the excitation voltages of 8V, 40 V,
and/or 80V. The readings should be the same as shown in step 7.
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Troubleshooting

The Troubleshooting Guide, Table 6-1, is arranged to help you evaluate the
reasons for TTR test set malfunction. The table lists possible test set
malfunctions which may be encountered during operation and lists possible
causes. Electronic circuit repairs should not be attempted in the field. Refer to
Repair section. Refer to Section 7 for a list of spare parts.

Table 6-1.

Troubleshooting Guide

MALFUNCTION

POSSIBLE CAUSE

Unit is not communicating or responding to
commands.

* No setvice power.
®  Defective line cord.
= Defective fuse(s).

®  Defective display or electronics.

Error message:
ANALOG OFFSET VOLTAGE HIGH
and/or

ANALOG GAIN OUT OF TOLERANCE
appears after self-test is complete.

Out of tolerance condition(s) in measurement
circuit.

Red TEST VOLTAGE ON lamp does not light
on start of testing.

*  Defective lamp.

= EMERGENCY TEST OFF switch is not
released.

* Problem in measuring circuit.

One of the following messages appear on the test
result screen.

=  CHECK CONNECTIONS

=  PHASE A (or B, or C) EXCITATION
CURRENT TOO HIGH;

= TURNS RATIO TOO LOW, <0.8; or PHASE A
(ot B, or C) TURNS RATIO TOO HIGH;

= CHECK PHASE A (ot B, or C)
CONNECTIONS, REVERSED;

= CHECK PHASE A (or B, or C) POLARITY

* Abnormal operating condition.

* Incorrect setting of TRANSFORMER TYPE
in the quick test setup or the full test setup 1
menus.

= Incorrect connection of leads.

= Defective test leads.

= Incorrect marking of a transformer.
* Problem in test specimen.

* Problem in measuring circuit.

RATIO and/or Iexc (mA) readings erratic.

®  Defective test leads (open circuit, poor
connection).

= Severe abnormal transient in service power.
* Problem in test specimen (poor connection).

* Problem in measuring circuit.
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Repairs

Any service or repair of this equipment should be performed only by qualified
persons who are aware of electrical hazards and the necessary precautions
required to prevent injury.

Megger offers a complete Repair and Calibration Service and recommends that
its customers take advantage of this service for routine maintenance or in the
event of any equipment malfunction.

In the event Service is required, contact your Megger representative for a product
Return Authorization (RA) number and shipping instructions.

Ship the product prepaid and insured and marked for the attention of the
Megger Repair Department. Please indicate all pertinent information, including
catalog number, serial number, and problem symptoms.
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Replacement Parts List and Optional
Accessories

Table 7-1. Replacement Parts List

Item Cat. No.
Three-phase Transformer Turns Ratio Test Set
120 V ac £10%, single phase, 50 £2 Hz or 60 £2 Hz, 100 VA TTR300
230 V ac £10%, single phase, 50 £2 Hz or 60 £2 Hz, 100 VA TTR300-47

Included Accessories

Canvas carrying bag for test leads 30915-211
Power supply cord, 8 ft (2.5 m) 17032-4
Ground lead, 15 ft (4.6 m) 4702-7
Hand-held switch assembly for LTC remote control testing 30915-220
PowerDB Lite Software

Serial cable for connecting to a PC 35248

Bushing clamps (6 pcs) MC7144
Instruction manual AVTMTTR300

Optional Accessories

Calibration Standard (for Operation Check) 550555
Inverter with 3 ft (0.91 m) cigarette adapter cord:
12V dc to 120 V ac, 60 Hz 35271-1
12V dc to 120 V ac, 50 Hz 35271-3
12V dc to 230 V ac, 60 Hz 35271-2
12V dc to 230 V ac, 50 Hz 35271-4
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Item Cat. No.
Test Leads

1-phase lead-set, shielded, clamp-end terminated

H and X windings, 30 ft (9.1 m) 37095
3-phase lead-sets, shielded, clamp-end terminated
H and X windings, 30 ft (9.1 m) 37093
H and X windings, 50 ft (15 m) 37094
Transit case for instrument leads and accessories 37009
Field Upgrade kits
TTR330 Interface panel 37089-1
TTR320 Interface panel 37089-2
TTR310 Interface panel 37089-3
TTR300 Interface panel 37089-4
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Specifications
Electrical

Input Power

Cat. No. TTR300: 120 V ac £10%, single phase, sine, 50 £2 Hz or 60 £2 Hz, 100
VA, IEC 1010-1 installation category 11

Cat. No. TTR300-47: 230 V ac £10%, single phase, sine, 50 =2 Hz or 60 £2 Hz, 100
VA, IEC 1010-1 installation category 11

Protective Devices

Fuses (2):

Cat. No. TTR300: Type T, 250 V, 3.5A (IEC 127 designation)
Cat. No. TTR300-47:  Type T, 250 V, 1.5 A (IEC 127 designation)
High voltage and low voltage measurement circuit shorting relays

Heavy duty varistors, transient voltage suppressors, and gas surge voltage protectors

Output Test Voltage and Current

3 test voltages: 80V rms, 40 V rms, 8 V rms.
Current: up to 500 mA

Test Frequency

Same as line frequency.
Loading of Test Transformer

Less than 0.2 VA
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Measuring Ranges

Turn ratio: 80 V ac: 0.8 to 45,000, 5 digit resolution
40 V ac: 0.8 to 25,000, 5 digit resolution
8V ac: 0.8 to 8,000, 5 digit resolution

Excitation Current: 0 to 500 mA, 3 digit resolution
Phase Angle T 90 degrees, 1 decimal point for the minutes display, 2
Deviation: decimal point for the degree display, 2 decimal points for the

centiradian display

Accuracy

Turn ratio:

80 V ac: +0.1% (0.8 to 2000)
+0.15% (2001 to 4000)
+0.25% (4001 to 10000)
+0.3% (10001 to 45000)

40V ac: +0.1% (0.8 to 2000)
+0.15% (2001 to 4000)
+0.3% (4001 to 10000)
+0.35% (10001 to 25000)

8V ac: +0.1% (0.8 to 2000)
+0.25% (2001 to 4000)
+0.35% (4001 to 8000)

Excitation Current (rms): (2% of reading + 1 digit)

Phase Angle Deviation: 13 minutes

Measurement Method
In accordance with ANSI/IEEE C57.12.90
Transformer Winding Phase Relationship

ANSI C57.12.70-1990
CEI/TEC 76-1:1993 and Publication 616:1978

AS-2374, Part 4-1997 (Australian Standard)
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Measuring Time
10 to 20 seconds depending on mode of operation and type of transformer
Display
Via external PC (user supplied)
Memory Storage
Via external PC (user supplied)
Interface

RS232 Serial

Environmental Conditions

Operating 23° to 122°F (-5 to 50 °C)
temperature range:

Storage temperature -58° to 140°F (-50 to 60 °C)
range:

Relative humidity: 0 to 90% noncondensing (operating)
0 to 95% noncondensing (storage)

Physical Data

Dimensions: 21.5x13.5x8.51in. (44.5x 26.5x 17.5 cm) (L x W x H)
Weight (test set): 25 Ibs. (11.5 kg)
Case: Ruggedized plastic case with removable lid and carrying strap
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Addendum A

TTR 300 Series PowerDB Lite User Manual

Introduction

PowerDB Lite is a free, but limited capability, version of the PowerDB software
tool that is designed specifically to control and/or extract data from Megger
instruments. The primary difference between PowerDB Lite and PowerDB is
that PowerDB is designed to work with all manufacturers’ equipment and has
tield and office synchronization capabilities. PowerDB Lite will present your test
data into a professional looking data form that can be sent to a printer or .pdf file
distiller such as PDF995.

PowerDB Lite allows you to use a sub-set of the standard PowerDB forms that
are appropriate for specific Megger instruments. PowerDB Lite detects the
instrument and enables the appropriate form(s). Data can be entered on-screen
or captured directly while using the test instrument. Completed data forms can
be saved as files to your computer.

Minimum Recommended System

- Operating System: Windows 2000 or later
= RAM: 64 MB RAM minimum, 512+ MB RAM recommended
. Processort: 300 MHz Pentium Class processor minimum, 1 GHZ or

better recommended

For information about the features of the full version of PowerDB please visit
our website at www.powerdb.com. Get acquainted with the following features
by scheduling a live demonstration at info@powerdb.com

. Synchronize All of Your Test Records Into a Single Corporate Database
" Reduce Test Time

. Improve Data Integrity
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Standardize Test Procedures
Easily Use Historical Trending for Evaluation of Test Results

Eliminates the Need to Install and Maintain a Software Application per
Instrument

Eliminates All Hand Written Test Sheets
Create Your Own Test Forms
Use or Modify One of Our 200 Built-in Test Forms

One Step Procedure To Generate Test Reports With Table of Contents
and Deficiency Summaries

Allows All Of Your Field Test Data To Be Integrated With CMMS
Systems Such As Maximo or SAP

Imports >From Many Other Industry Standard Software Applications

Controls and Imports Data From Many non-Megger Instruments
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Software Installation

To install PowerDB Lite, load the PowerDB Lite CD into your CD-ROM drive

and follow the on-screen instructions.

1. Accept the terms of the License agreement.

PowerDE - InstallShield Wizard

License Agreement

Pleaze read the following license agreement carefully.

Press the PAGE DOWM key to zee the rest of the agreement.

POER DE, IMC. -
SOFTWARE LICEMSE AGREEMENT

READ THE FOLLOWIMG TERMS AMD CONDITIONS BEFORE INSTALLING THE
SOFTWARE. IFv0OU DO MOT AGREE WITH THEM, PROMPTLY RETURM THE

SOFTWARE AMD THE ACCOMPANYING ITEMS [INCLUDING MANUALS) TO:
FOWER DE. IMC.

4064 STATE HIGHw2Y 6 SOUTH
COLLEGE STATIOMN, TEXAS 77345
FOR & REFUMD OF THE PRICE FAID.

-

Do vou accept all the terms of the preceding License Aqreement? If you zelect Mo, the setup
will cloze. Toingtall PowerDE, you must accept this agreement.

Tes & [x]

2. Choose the destination location for the PowerDB Lite files.

PowerDB - InstallShield Wizard

Chooze Destination Location

Select folder where zetup will inztall files.

Setup will install PawerD B in the following folder.

Toinztall to this folder, click Mest. Taoinstall to 5 different folder, click Browse and select
another folder.

Destination Folder

C:\Program FileghPoveerDE IncPowerDB"

Browse...

< Back et = |

Cahicel |
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3. Select Default Settings.

r 3
Default Settings ﬁ

Language:

Default Units:

Imperial j

InstallShield

< Back | Mest » I Cancel

4. InstallShield Wizard will complete the installation of PowerDB Lite. Click
Finish to close the installation program.

PowerDE - InstallShield Wizard

InstallS hield Wizard Complete

Setup has finizhed instaling PowerDE on vour computer.

< Back | Firish I Cancel
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Using PowerDB Lite

1. Home

1. Select your Instrument from the Instrument Setup screen.

a. You can always view the Instrument Setup screen from the Tools
menu or F3.

b. Select the appropriate row in the Description column.
Then click the “...”” button in the Setup column.

Drezcription | Setup |
Current Transformer

E arth Farmz

t egohmmeter

Poweer Factor Test Set
Time Domain A eflectometer

Tranzformer Turnz B atio

Learn mare about PowerDB:  hitp: A Awene, powerdb, come about!

Wiew all forms shipped with PowerDB:  kttpe vy, powerdb, comeforms,
Far technical zuppart call:  1-800-723-2861 »3519

c. 'The TTR 300/310 only uses setial communicate, so never check ‘Use
Ethernet’ if you are using a TTR 300 or TTR 310. Select the
appropriate communication settings on the Serial Device
Configuration screen. Use the Refresh button to find any ports that
may have not been connected at the startup of PowerDB Lite. If you
are using a USB serial port and do not know the port assigned to it
please perform the following:

1. Remove the USB serial adapter
2. Press Refresh

3. Click on the port drop down and record the options

>

Plug the adapter back in

5. Press refresh
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6. Select the port that was not in the original list

Verify that the baud rate is set to 9600, Parity is set to none, Byte Size is set to 8,
and Stop Bits is set to 1.

d. Only check ‘Use Ethernet’ if connected to the TTR330. If you leave
the IP address blank PowerDB Lite will discover the unit. If you
have problems with the discovery enter the IP address which is
displayed on the instrument’s Preferences screen.

Serial Device Configuration E|

Instrument Use: |Transf0rmer Turns Ratio

Manufacturer: |"§‘\""D # Megger

Model/Type/Senes: |TT R
Supported Models: |3'F'|"‘E'SE TTR

Serial Port: ,—Ll Refrezh Byte Size: m
Baud Rate: ’m Parity: ’m
Stop Bits: 1 -
[ UseEthernet

Ok | Cancel J

e. 'Then Click OK on the Instrument Setup Screen to finish.

2. OpenaNew Form

a. Select the File>New menu item, or type CTRL+N, or press the New
toolbar button.

b. The forms associated with the detected instrument will be shown in
the Select 2 Form screen.

c. Choose a form by double-clicking or by navigating with the arrow
keys and pressing the OK key.

d. See Specific Form Help Instructions for further instruction on test
steps. You can view the Form Help by pressing the F1 key once the
form is loaded.
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Select a Form

TRAMSFORMERS
2-TTR MULTIPLE QUICK. TESTS

4 -5IMPLE 3PH TTR
56365 - 3PH TTR WITH TAP CHAMGER

3-TTR MULTIPLE SINGLE PHASE QUICK. TESTS

Canicel

3. Enter Test Data

form.

Header and nameplate information can be manually typed into a

Click the Initialize Instrument button 44  to initialize the test set.

Form fields with automation will now be colored cyan. Right-clicking

these fields will start the test.
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d. To change the settings of the TTR place the mouse on the form and
right-click. Then select “TTR Settings”.

TTRPrefs x|
TTR Settings

Showy Diag Numbzr |?

Standard
Test Voltage

Q. |

e. 'This dialog box allows you to change the TTR settings. The settings
that can be changed are as follows:

1. Show Diagram Number
When enabled this will display a numeric field below the

winding configuration diagram on the form. The diagram
can then be changed by entering a number in this field.

2. Standard

This enables you to choose between the ANSI, Australian, or
IEC Standard.

3. Test Voltage
This enables you to choose the test voltage at which the test
is run. Auto allows the instrument to choose an acceptable

test voltage for testing. You may choose between Auto, 8,
40, or 80.

4. Running an Automated Test

a. Select the Initialize Instrument button. 24
b. Automated fields should now turn cyan colored.
c. Right-click on the cyan colored fields.

d. Follow the on screen instructions specific to the test.
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5. Comments and Deficiencies

When imported into the full version of PowerDB, the comments and
deficiencies on each form are used to generate summary reports. These
summary reports repeat the notations and lists the page number where reported.
This allows the user to scroll to a particular page to view a reported anomaly.
For more information on features of PowerDB visit us at our website at
www.PowerDB.com.

6. Save the Data

Select the File>Save menu item, or press CTRLAS, or press the Save
toolbar button.

The Save As screen will allow you to specify a location and file name
for your PowerDB Lite XML file.

Save in: | [ PowerDB ﬂ |‘=j€ FEEE R
File narne:
Save az type: |F'n:|werDE #mL File [* Pdbml] ﬂ Cancel
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7. Opening an Existing File

a. Select the File> Open menu item.

Loak in: |@ PowerDB ﬂ =5 ER-

File name: |p|:|b3=<|'-.-1L
Files of type: | PowerDB <ML File [*. Pdbiml] | Cancel |

[ Open as read-only

b. Browse to the file you would like to open.

c. Press the Open dialog button.

d. d. If the file contains multiple test dates, select the date that you
would like to open for editing or select New to append a new set of
results to the file. To remove a set of results, click on the selected file
and press the delete button.

Form name: 4 - S5IMPLE 3PH TTHR

To view or edit a set of resulks, Test Date | Open
zelect a test date and press the =
Open buttan. ﬂ EEDD L 4'2?'D

=1

Toremove a set of results, select a
tezt date and press the Delete
buittar.

4l

Delete

Prezs the Mew button o enter
anather set of kest results.

Cloze
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8. Loading Data Files

When testing with the TTR 320 or TTR 330 you may load files saved on the
instrument’s USB drive. Refer to Step 7 for instructions on selecting and
opening files.

9. Setting the Logos

a. Select the Tools>Options menu item.

b. The Logos section specifies paths to the left and right logos files to
use.

c. To change the left logo press the “...” button by the left logo path.

d. The Open screen allows you to browse to a file location, select a
JPG or .BMP file, and press the Open button.

e. Repeat steps (c) and (d) for the right logo path.

f. Note that a logo will not be shown if the logo file path is blank or the
file does not exist.

g. Note after specifying the logo files the image will not be shown until
the next time a form is opened (File>Open, or the File>New menu
items).

h. Note that the logos will look the best if the resolution of the file is
pixels wide by 240 pixels high. DPI is not important.

Language

InternationalE naglish

Measurements

Default Unitz: | Metric -
Temperature Unitz. |[°C «

Logos

L eft: |I::\F'mgramFiIE$\F'uwerDBInc\PowerDE\puwerdb_megger_&lug J

Right: |E:\PrngramFiIes'\F’DwerDBInc'\F'owerDB\your_company_logo.br J

ok | Cancel |
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10. How to change Languages

a. Select the Tools>Options menu item.

b. Select the appropriate language in the dropdown menu.

Options g|

Language

InternationalE nglish

hMeasurements-

Default Unitz: | Metric hd

Temperature Units:  |*C »

Logos

Left: IE:\F‘ngram Filez'\PowerDE Inc\PowerDB\powerdb_megger_zlug J

Right: ]E:'\F'n:ugram FileshPowerDB Inc\PowerDB\pour_company_logo.br _]

Ok, | Cancel I

11. How to change units of measurement

a. Select the Tools> Options menu item.

b. Select the units in the drop down Default Units under Measurements

Language

Internationalk nglizh

Meazurements

Default Unitz: | Metnc -

Temperature Unitz:  [*C

Logos

Left: |E:'\F'rugram FileshPowerDB Inc\PowerDB\powerdb_megger_zlug _]

Right: JE:\F‘rugram Filez'PowerDE InchPowerD B \your_company_logo. br J

]S | Cancel |
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12. Additional Notes

a. Additional forms can be filled out by repeating steps 2, 3 and 0.

b. TForms can be printed with the File>Print menu item, or type
CTRLA+DP, or press the Print toolbar button.

c. A help guide may be found in the Help>PowerDB Lite Help menu
item.

Frequently Asked Questions (FAQ’s)

1. CanI change the forms?

No. You must have the full version of PowerDB to change forms.

2. Can I synchronize forms to a database?

No. You must have the full version of PowerDB for database support and to
synchronize multiple field databases to a single master database.

3. Can I import PowerDB Lite files into PowerDB?

Yes. You can use the File>Import menu item in PowerDB to import files from
PowerDB Lite.

AVTMTTR300 Rev B Sept 2008 57



Megger.

Specific Form Help Instructions

Operating Instructions for the Multiple Quick Test Form

Type in the asset ID and then press the Enter key.

Use the left and right arrow keys to select the high-side winding
configuration.

Press the Enter or Tab key.

Use the left and right arrow keys to select the low-side winding
configuration

Press the Enter or Tab key.

Select the test voltage from the dropdown menu, then press Enter or

Tab.

Type in the high side tap number and press the Enter key.

. Type in the high side voltage and press the Enter key.

Type in the low side tap number and press the Enter key.

Type in the low side voltage and press the TEST key (F2) or right
click on the blue highlighted fields.

Hit the Enter key and repeat for each tap you would like to test.
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EBPowerDB Lite (Transformer Turns Ratio)

File Edit View Tools

=Bl x|

Help

=== ==

Y EEEEEEYG)

ASSET ID:

55| Megger.

(Press F1 for form operation instructions)

| Your |
Company
l Logo

Select Test volfage: At TEST DATE: 6/20/2008
High Side Low Side Hy —Hg / X1 - Xo o~ Hy / %o - X3 Ho - Hp / X~ %q ™
Voltage Voltage | Calc [ Actual O Iexc |Phase | Actual O Iexc | Phase | Actual O Iexc | Phase
#lTan & | qy) (TP #| @) | Ratio | Ratio | Error mA | (min) | Ratio | Error mA (min) | Ratio | Brror [ mA (min)
N !
COMMENTS: [ I
DEFICIENCIES: | |
Kl | o[z
. . A
Operating Instructions for the Simple 3PH TTR Form

This form can be used for testing a two or three winding transformer with
multiple taps on one or more of the windings.

If you are testing a three winding transformer please check the “Has Tertiary”
checkbox.

Next select the winding configuration by using the left and right arrow keys.
Press the Enter or Tab key to move to the next field.

The default total number of tests is defined as follows:
1. Test for each secondary (or tertiary) tap tested with the primary nominal tap.

2. Test for each primary tap with the nominal secondary (or tertiary) tap.

If you do not wish to test all of the secondary or tertiary taps you can reduce the
“# tests” field for each category of tests (primary, secondary, tertiary).

Once the total number of taps and the # tests field are entered the form will
display the correct number of rows to perform testing.

Once the voltage is entered for the first and last tap values (from the
transformer’s nameplate tap voltage table), the ratios for all taps will
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automatically be calculated and populated. Please note that the calculated values
can be over written.

Right click on each of the blue highlighted fields in each table to run the tests.

EBPowerDB Lite (Transformer Turns Ratio) -0 x|
File Edit Wiew Tools Help

=BH S a|Ex =% [P R EER&
(Press F1 for form operation fnstructions) ;I
e
27| Megger-. TURNS RATIO TEST Company
SUBSTATION POSITION PAGE
EQPT. LOCATION DATE
AZSETID AMBIENT TEMPERATURE °F HUMIDITY % JOB #
EQPT. INVENTORY MO TESTED BY
H, Iyl WVOLTAGE (kW] KA [RATED I [#TAPS [NOMMAL] CHANGER |
5 2 [FRIARY 5 3 Of Load
f%—@ A [SECOND: / 1
*3
b
Hy i Hy x Round Tap Valtages To: Has Teriary. [
? ?gg Diagram # 36 Tap One is Listed: Test Voliage.
frat T ;PL}’O j{fg-ff _ HIGH SIDE TAPS TO LOW SIDE NOMINAL TURNS RATIO TESTS
Number Of Tosts & Hi-Hg 7% -3 Mo -y 1% X H3-Ha/¥3-% )
PRIMARY SEC HGH SIDE  [LOWY SIDE CALC . . . .
TAP TAP VOLTAGE |VOLTAGE RATIO Ratio | Etrar lexc  |Phimin) | Ratio Errar lexc  |Phimin) | Ratio Error lexc  |Phimir)
1
2
3
- -
« - i 7
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Operating Instructions for the 3PH TTR with TAP Changer Form

The procedure for this form is the same as the Simple TTR form. The only
difference is that it allows the user to enter additional nameplate information.

=lolx|

EBPowerDB Lite (Transformer Turns Ratio)
File Edit wiew Tools Help

FEIEIEL EEEE IEEEEEEYE
(Press F1 for form operation instructions) d
Yo
4rz| Megger. TURNS RATIO TEST ICW;;;W I
SUBSTATION POSITION PAGE
EQPT LOCATION DATE
ASSETID AMBIENT TEMPERATURE °F HUMIDITY i) JOB#
EQPT. INVENTORY MO TESTED BY
NAMEPLATE DATA  Has Tertians: [ Found Tap Volages To [T Vel Tap One s Listed” [First
Test Vatage
Dieg # Hy i, MFR VEAR EUSHING NAMEPLATE
35 SERNO _ WEATHER DSG[_ SERIALNUM WFR TVPE/CLASS | kY| AMPS [YEAR
Rstio M < a WEIGHT LG TEMP °C [
: — 4 TYPE EIL R
a CLASS PHASES [
Hy Hy x4
CODLANT WDG MATERIAL _Cu [
Diagram # 5 REASON —_ ALLOWEDERR 0.5 %[
Test Vaoltage K OlL YOLUME GAL w2
[FOLTAGE (ev)] e |RATED | [#TADS [NOMINAL] CHANGER TAD SETTNG] | %3
[FRART. 5 3 Off Load ]
SECOND: 7 7
iﬁ:;ﬁﬁﬁg HIGH SIDE TAPS TO LOW SIDE NOMINAL TURNS RATIO TESTS
Murmber OF Tests © I Hi-Hg /% - %3 e Ho-Hy 1 -3 e Hy-Ho /X3 - % N
4 » A
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